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Introduction

VMware SCAP Edit is an updated version of the Enhanced SCAP Content Editor tool by
G2, Inc. The modified tool builds on similar capabilities but few subtle differences required
to build OVAL content based on latest OVAL schema.

The major changes done by VMware are as below:
e Added support for OVAL 5.11 for Independent, Unix, Linux and Windows schemas
e Added support for XCCDF 1.2 creation from OVAL
o Refreshed the tool with modern Ul
e Dropped broken capabilities from previous versions of the tool
e Dropped obsolete schemas and all other seldom used features
e Updated libraries to latest versions
e Updated CPE version to 2.3
e Restructured the code
e Removed obsolete and unneeded libraries

These changes make the tool simple and intuitive to build OVAL content specially aligned
with the latest 5.11 OVAL schema. Also, it can now create XCCDF 1.2 content directly
from OVAL file.

Note: This tool and the documentation below assumes that you are fairly aware of SCAP,
OVAL, XCCDF and the surrounding scheme of things. If you are not, please take a
moment and familiarize yourself with these before proceeding further.

Installation and getting started

System Requirements

¢ A Java Runtime Environment (JRE) preferably 1.8 or later.
e 1 GB of memory.
e Supported OS — Microsoft Windows and Linux (with support for JRE).
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http://www.g2-inc.com/escape
https://github.com/OVALProject/Language
https://scap.nist.gov/specifications/xccdf/#resource-1.2
https://nvd.nist.gov/cpe.cfm
https://scap.nist.gov/revision/1.2/
http://www.oracle.com/technetwork/java/javase/downloads/jre8-downloads-2133155.html

Installation

1) Extract the VMware SCAP Edit 1.0.0.zip file.

2) Navigate to the extracted directory.

3) If you are running a Microsoft Windows system, execute startEditor.bat file. This
will launch the tool. If you are running a Linux system, execute startEditor.sh file
to launch the tool.

These scripts will call Java with the appropriate arguments. These can be edited if you
need to give Java more memory or set some other system property. Editing these files
is only recommended for advanced users.

Using the tool

Launch the tool. You would see the tool interface as below:

As you immediately notice, the tool has been simplified from its parent version. It now
just has a file menu that offers you below core capabilities:
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1) Creating a new OVAL file
2) Opening an existing OVAL file
3) Creating a XCCDF file from an existing OVAL file

All other functionalities from the parent version have been taken out. Now, let us see each
of the three functionalities in depth.

Creating a new OVAL file

Launch the tool. Navigate to File > New OVAL.

Ll Ll Create a new empty OVAL definitions document
XCCDF From QWA
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This opens a new dialog box with default OVAL 5.11 schema chosen. We have removed
all other obsolete schema.

Flatform type selector | Choose name for new OVAL file |

Select an OWAL Schema Yersion for the new OVAL Document

OWAL Schema Version

Click Next.
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Now, select the target platform. You may now only choose between Independent, Linux,
Unix and Windows. We have dropped the support for any other platform.

For example, let us choose Unix.

[mw_ Schema Version M Choose name for new OVAL file

Select ane or more plalforms to which the definitions in the new OVAL Document will
apply

independent
linux

unix
windows

Click Next.
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Finally, choose the file name.

| OVAL Schema Version | Platform type selector

Overview

Click the Choose File bulton to select a name for the new OVAL file. If you select
an existing file, it will be overwrilten. If you enter a new file name, it will be created.

L

Filename must end in -cpe-oval xml’, -patches xml’, or -oval.xml’

Cilsers\kayushiDeskiopitest-oval xml

Status The file name is valid.

| Back || Finish |

Click Finish.
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This creates a new and blank OVAL file.

File Help

‘OVAL Document -

Search | |

OVAL 5.11 Definitions Document(C-]
» (B Definitions(0)
» (& Tests(0)
» (&5 Objects(0)
» (B States(0)
» (B Variables(0)

-« g |

| Epandan | | collapsesn |

[ Dennitons Doc |

General Details
-

Filename: CiUsersikayushiDeskiopitest-oval xml

Timestamp

OVAL Generator Details

-
Product Name WViMware SCAP Edit
Product Version 1.0.0
OVAL Schema Version 511

2016-07-06T01:54:21

This tool helps you define various OVAL components:

o Definitions

e Tests

e Objects

e States and
e Variables
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You can define those components individually and then link them up together later. But,
for this example, let us walk through a typical flow in creating an OVAL definition.

Adding a new OVAL definition

Let us take an example that we want to write an OVAL definition that verifies that the
/etc/passwd file is owned and group-owned by root and has permissions of 644.

Start with adding a Test. Right click on Tests and then click Add Test.
g VMwareSCAPEGt100

File Help

v ﬁ OVAL 511 Definitions Document{C:
> ﬁ Definitions(0)

» [ Variables(0)

AN bl

| Bxpanoan | | collapsesn |
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For your first test only, you will have to define OVAL base identifier.

OVAL Base Identifier

The "0OVAL base identifier” is used by this editor as the first part of the id field of any
MHEW OVAL definition, test, object, state, orvariable that the editor creates. ltis stored
with the OWVAL document. For example, inthe OVAL definition id
oval.gov.nist.fdcc.vista: def 6007

the part ofthe id shown in red is the base id.

cnrn.'u'rnware.uni)d

oK J|_cancel |

For this example, let us set the base identifier to com.vmware.unix. You can set this up
as you would require.

Click OK.
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Now, choose the target platform for which you are writing this test. Let us choose Unix
here.

Type | Objectand State |

Qverview

Pick one ofthe plalforms below. The list below represents those platforms valid for this version of the OVAL schema.

Platform

independent
linux

windows

Page 1 of 2 Back Cancel

Click Next.
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Now choose Test type or OVAL probe against which you want to define the test. Check
references to read about these in detail.

out the

Pick type

Type

Docu

dnscache_test

The g
domai
from
oval-
infor
3taty

fileextendedattribute_test
gconf_test

inetd_test

interface_test
password_test
processhd_test

Page 2 of 3

For this

example, let us choose file_test. Using this test type we can check various
attributes on files such as ownership and permissions. Click Next.
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As you know, each test is comprised of objects and states. On this screen, we will define
objects and states to match our requirements (checking /etc/passwd file for ownership
and group-ownership to be root and permissions of 644).

| Prattorm | Type | Objectana state |

General
-

Testld | oval:com.vmware. unixtst 1

TestType file_test

Comment |Default comment, please change

e

Check Existence [a.t _least_one_exists H

State Operator

Atest must pointto an object to be valid.

ObjectId No Value Set || Choose Object
L.

State(s)
E

This version of QWAL allows multiple states to be set per test.
State Add

Remuove

Move Up

.

Page 3 of 3 | Back || Finish |
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As you notice above, the base identifier is preset. Also, you don’t have to manage the ids
yourself once you define the base identifier. The tool keeps incrementing the ids as you
add more tests. The same holds true for any other OVAL components such as definitions,
objects, states and variables that you write. All the ids are taken care of by the tool.

Also, all the OVAL defaults for various fields such as Check, Check Existence and State
Operator are preset. You can use the drop down to pick and choose the various options
as matching your requirements.

Now, let us go ahead and define the test as needed by our requirement.
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We start by giving a Comment.

| iatorm | Type | oojectana state |

General
-

Testld | oval:com.vmware. unixtst 1

TestType file_test

Comment |‘u'erify that /etc/passwd file is owned and group-owned by root and has permissions 644|

e

Check Existence [ai _least_one_exists H

State Operator

Atest must pointto an object to be valid.

ObjectId No Value Set || Choose Object
L

State(s)
-

This version of OVAL allows multiple states to be set per test.
State Add

Remuove

L Maove Up

Page 3 of 3 | Back || Finish |
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Now click on Choose Object.

This opens up Object wizard.

Objects
null(0)

Filter

e

Mew | Clone |

Click New.
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This opens up New Object wizard. Give a comment. Right click on the below shown area

to add parameters.

[ Parameters |

Comment |fetc.rpa,sswd

|| Use Behaviors

Behaviors

Behavior . _v | Add |

Edit |

Remove |

IR Structure for OVAL Objechausioam

Add parameters

1

oy b

Page 1 of 1  Back | Finish
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Since, we chose test type as file_test, only below corresponding object parameters are
available.

Available parameters

filepath
path

filename

Here, let us choose to give absolute path of the file. In our example, itis /etc/passwd.
Click OK.
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Comment  jetcipasswd

|| Use Behaviors

Behaviors

Behavior | v| Add |

. Edit |

Remuove

L

¥ ﬁ Object parameters
B rParame

- Back | Finish

Right click and select Edit to set the value for filepath object parameter.
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Parameter file_object
Data

Datatype string
Operation [Eq_lajg H

Datasource

Where is the data for this parameter?
(®) Defined Here(_) AVariable

Data defined here

Data

b

Data defined in a variable

Variable check | all

Variable 1d | Choose Variable |

In this wizard, click on Edit and define the parameter value.

String Value | jatcipas sw

oK J|_cancel |

Click OK.

The value gets set for filepath.
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Parameter file_object
Data

Datatype string
Dperation [eq_.ajs H

Datasource

Where is the data for this parameter?
(®) Defined Here(_) A Variable

e

Data defined here

Data leto/passwd

e

Data defined in a variable

Variable check | all v |

Variable 1d | Choose Variable |

oK J[_cancer |

Click OK.

The object is now defined.
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Comment  jete/passwd

|| Use Behaviors

Behaviors

Behavior | | Add |

| Edit |

Remove

.

¥ ﬁ Object parameters
B Parameter(string | equals) filepath = fetclp

- Back | Finish |

Click Finish.
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Object is now chosen for the corresponding test.

Objects

¥ (& nulii1)
v (& file(1)

B oval:comvmware unixobj 1 - letc/passwd

Filter

[New][{:mne]

Cancel

Click OK.
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You will now see that the object id is populated in the test.

| Piatrorm | Type | Objectand state |

General
-

Testld ‘ oval:com.vmware.unixtst 1

TestType file_test

Comment “u’erify that /etc/passwad file is owned and group-owned by root and has permissions G644

cre
I

Check Existence [a.t _least_one_exists H

State Operator

Atest must pointto an object to be valid.

Object |d |cmal:commmare.unixobi1 | Choose Object
e

State(s)
-

This version of OVAL allows multiple states to be set pertest.
State Add

Remove

Move Up

L

Page 3 of 3 | Back | | Finish |

Now, let us follow similar steps and define states. You can define multiple states per test.
In our example, the states to be defined are:

e group_id=0
e user id=0
e Permissions 644
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o uexec=0
o gwrite=0
o gexec=0
o owrite=0
o oexec=0

In the state definition area, click on Add.

| Piatorm | Type | Opjectana siate |

General

-

Testld | oval:comyvmware. unixtst

TestType file_test

cre

Check Existence [a.t _least_one_exists H

State Operator

Comment |‘uferify that fetc/passwd file is owned and group-owned by root and has permissions 644

Atest must point to an object to be valid.

Object1d | oval:com.vmware.unix.obj:1

L.
State(s)
-

Conmseomes

This version of OWAL allows multiple states to be set per test.

State

Add

Remove

Move Up

| Back | | Finish |

vmware




The state wizard opens up. Click New.

States

null(0)
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Define a new state. First, give a Comment.

Comment |Dwnerships root. Permissions| 644

Possible parameters

Parameter [mepam H Add

The filepath element specifies the absclute path for a file on the machine.
L directory cannot be specified as a filepath.

Added parameters

MName Edit

Remove

Back Finish
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Then, add all the state parameters needed from the parameter drop down list, one at a

time.

Comment |Dwnerships root. Permissions G44

Possible parameters

Parameter [oexec

Can the other users execute this file cor, if a directory,
directory?

change into the

Added parameters

Edit

Mame Operation Datatype

group_id equals int

user_id equals int

LUexec equals boolean
gwrite equals boolean
gexec equals boolean
owrite equals boolean
oexec equals boolean

Remove

Page 1 of 1 Back Finish
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Then select each parameter and click Edit to set the desired value.

Comment |Dwnerships root. Permissions 644

Possible parameters

Parameter [uexec

e

Can the owner {(user owner) of the file execute it or,
change into the directory?

if a directorv,

Added parameters

MName

Operation

Datatype

Edit

group_id
user_id
uexec
gwrite
gexec
owrite
0exXec

equals
equals
equals
equals
equals
equals
equals

int

int

poolean
boolean
boolean
boolean
boolean

Remoaove

Page 1 of 1

Click Finish.
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Choose the state you just created.

States

¥ (& nullg1)
¥ (&5 file(1)

B oval:comvmware unixste:1 - Ownerships root. Permissions 644

Click OK.
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Now, the test is complete. We defined all the test elements.

Search ‘

¥ (& OVAL 6.11 Definitions Document(C: m
» (B Definitions(0)
¥ (5 Tests(1)

¥ (& file(1) Testld | oval:com vmware unixtst 1 |

General

Test Type file_test

» (5 Objects(1)
> [ﬁ States(1) C |Verifylhat fetc| dfile is owned and group-owned by root and has permissions 644 |

» (& variables(0) Check
Check Existence | at_least_one_exists Ad
Version

l 15

Test Detail

u Object

Atest must pointto an object to be valid.

Object Id|oval:comymware.unixabj: 1 /| choose Object

State(s)

This version of OVAL allows m.llllple states to be set per test.
State ( Add J
oval:comyvmware. unixste:1 - Dwnerships root. Permissions 644

Remaove

Move Up

Move Down

- -/ T
| ExpandAl | | Collapse Al |

The next step is to link the test to an OVAL definition.
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Right click on Definitions and select Add a definition.

File Help

Search | |

v ﬁ ‘OVAL 5.11 Definitions Document{C:
» = Definitions(
» 55 Tests(1)

» [ Objects(1)
» (55 States(1)

» (& variables(0)

- J T
Expand All } [ Collapse All ]
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This would open OVAL definition wizard. In this wizard, choose the definition Class from
the drop down and provide a suitable Title and Description for the definition.

[ General | References | Affected |
Class

| COMPLIANCE

Title

Ensure that fetc/passwd file has correct altributes

Descrioti

This rules verifies that the /etc/passwd is owned and group-owned by root and
has permissions of 644

Click Next.
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Add references if you want to. This is optional.

@ Create new OVAL definition

_[ General | References | Afectec

d | Source un [ Add |

rom Clipboard

Page 2 of 3 | Back || Next | Cancel

Click Next.
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Add affected platforms and products. Right click on Affected elements and select Add
affected element.

[ General TRefe:ences H

e T L —— To Clipboard
Add affected element

From Clipboard

Page 3 of 3
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In our example, we will choose Unix.

Click OK.

Then, define a specific platform or product. Right click on Affected<unix> and choose

the target as needed.

[ General T References M

Affected groupings

v ﬁ Affected elements
> [ Affected=unix

Add Platform

Add Product

To Clipboard

From Clipboard
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For our example, let us give SLES 11 as the target platform. An entry for it will look like
below.

String Value | cpe-jo:sles11:linuy

oK J[_cancel |

Click OK.

[ General T References M

Affected groupings

¥ = Affected elements
¥ ﬁ Affected=unix=
plalfform=cpelo:sles11:linug=

| Back || Finish |

Click Finish.
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This adds a new OVAL definition. Now, we will link this definition with a test. Definitions
can have one or more tests. In our example, we will associate this definition with the test
we created in earlier steps.

Search |
¥ [& OVAL 5.11 Definitions Document(C: M Metadata | Criteria | Source |

¥ (&5 Definitions(1) e

L4 ﬁ compliance(1)

» (55 Tests(1) Class COMPLIANCE v

» (&5 Objects(1)

- ﬁ States(1) Id: |oval:com.vmware.unix:def.‘l

> (E5 variables(0) Title:

: Ensure that fetc/passwd file has correct altributes
u Version
| 15
References Summary
Id Source url
< e
| Bpandal | | collapsean |

Click on Criteria tab.
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@&  OVALDocument-CiUserskayshDeskioptestoalxmimoditey  OE=

Search | |

v ﬁ OVAL 511 Definitions Document{C: [ General TMeiadala M’ Source]
¥ (& Definitions (1) S
» (B compliance(1) B No Criteria defined
» [ Tests(1) Add criteria
» (B Objects(1) —_—
» (B States(1)
¥ (& Variables(0)

Status

< — —

[ Expand All ] [ Collapse Al }

Right click on No Criteria defined and then choose Add criteria.

Choose criteria operators (defaults are preset) and provide a Comment and then click
OK.

Operator
oz

Comment, 1ozt for etc/passwd|

[ ox J[_canc |

vmware



@ ovALDocument.CiserskayushDesktoptestoalxmimoditie)  BE&

Search | |

v [i OVAL 5.11 Definitions Document(C: General | Metadata m Source
¥ (& Definitions(1) [ T ]

» (E§ compliance(1)

I Criteria<AND= - Test for et

> [ Tests(1) Edit
» (B3 Objects(1) Delete

L ﬁ States(1) Add crflerfa
L - Variables(0) Add criterion

Add criterion elements via tests

Add definition reference

Status

All criteria must have at least one child!

<L A Ll
| Bpandan | | collapsean |

Now right click on Criteria to choose Add criterion elements via tests.
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Available tests
file_test{oval.com.ymware.unixist. 1) Verify that /fetc/passwd file is owned and group-owned by root and has pe

<

Tests to add criterion elements for

| Remove selected |

Select the desired Test and click on Choose selected.
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Available tests

| Choose selected |

Tests to add criterion elements for

file_test{oval:comvmware. unixtst:1) Verify that letc/passwd file is owned and group-owned by root and has pe | Remove selected |

Click Ok.
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This will add the test to the definition.

8 ovalDocumen-ClserskayshDeskiopiestoabxmimoniied)  BE&)

Search | |

7 (5 OVAL 5.11 Definitions Document(C:| | [ General | Metadata m Source |

¥ [& Definitions(1) —
» (B compliance(1) ¥ (&5 Criteria<AND: - Test for etcipasswd

* (& Tests(1) Criterion=oval comymware unixctst 1= - Verify that /etc/passwd file is owned and group-owned by root and has permissions 644
» (B Objects(1)
» (i states(1)

L ﬁ Variables(0)

Status

A = >
| Expandan | [ collapsean |

Go to File menu and choose Save. Done!

This completes adding your first OVAL definition and the required elements.

The generated XML file looks like below:
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<? version="1.8" encoding="UTF-8"?>
< xmlns="http://oval.mitre.org/XMLSchema/oval-definitions-5" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xmlns:oval
="http://oval.mitre.org/XMLSchema/oval-common-5" xmlns:oval-def="http://oval.mitre.org/XMLSchema/oval-definitions-5" xmlns:unix-def="http://
oval.mitre.org/XMLSchema/oval-definitions-5#unix"” xsi:schemalLocation="http://oval.mitre.org/XMLSchema/oval-definitions-5 oval-definitions-
schema.xsd http://oval.mitre.org/XMLSchema/oval-common-5 oval-common-schema.xsd http://oval.mitre.org/XMLSchema/oval-definitions-5#unix unix-
definitions-schema.xsd">
< >
>VMware SCAP Edit</
>1.0.0</
PRI
>2016-087-06T01:54:21</

id="oval:com.vmware.unix:def:1" version="1" class="compliance">
>
>Ensure that /etc/passwd file has correct attributes</ >
family="unix">
>cpe:/o:slesll:linux</ >
>
>This rule verifies that the /etc/passwd file is owned and group-owned by root and has permissions of 644.</
>
>
operator="AND" negate="false" comment="Test for /etc/passwd">
comment="Verify that /etc/passwd file is owned and group-owned by root and has permissions of 644." test_ref=
"oval:com.vmware.unix:tst:1" />
</ >
</ >
>

< xmlns="http://oval.mitre.org/XMLSchema/oval-definitions-5#unix" id="oval:com.vmware.unix:tst:1" version="1" check
="all" comment="Verify that /etc/passwd file is owned and group-owned by root and has permissions of 644." check_ existence="
at_least_one_exists">

< object_ref="oval:com.vmware.unix:obj:1" />

< state_ref="oval:com.vmware.unix:ste:1" />
</ >

< xmlns="http://oval.mitre.org/XMLSchema/oval-definitions-5#unix" id="oval:com.vmware.unix:obj:1" version="1"
comment="/etc/passwd">

< datatype="string" operation="equals">/etc/passwd</ >
</ >

< xmlns="http://oval.mitre.org/XMLSchema/oval-definitions-5#unix" id="oval:com.vmware.unix:ste:1" version="1"
comment="0Ownership root. Permissions 644">
< datatype="int" operation="equals" entity_check="all" var_check="all">@</ >
datatype="int" operation="equals" entity_check="all" var_check="all">@</
datatype="boolean" operation="equals" entity_check="all" var_check="all">false</
datatype="boolean" operation="equals" entity check="all" var_check="all">false</
datatype="boolean" operation="equals" entity_check="all" var_check="all">false</
datatype="boolean" operation="equals" entity_check="all" var_check="all">false</
datatype="boolean" operation="equals" entity check="all" var_check="all">false</

Now, you can run this OVAL definition using a tool such as VMware STIG compliance
tool on the target platform.



https://blogs.vmware.com/security/2016/05/vmware-releases-stig-compliance-app-for-free.html
https://blogs.vmware.com/security/2016/05/vmware-releases-stig-compliance-app-for-free.html

Opening an existing OVAL file

To open an existing OVAL file, go to File > Open OVAL.

Browse the file, select it and click Open.

LookIn: [ﬁ' Desktop

test-oval.xml

File Mame: |test—wal.xm|

Files of Type: | OVAL files
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This would open up the OVAL file that we just created.
T —"O oo e | olse v une st iopeiople s o — T I

Search | |
v ﬁ OVAL 5.11 Definitions Document{C: iﬂ Metadata | Criteria | Source
¥ (& Definitions(1)

v fi compliance(1)

@ oval.comvmware.unixdef. 1 Class COMPLIANCE
¥ [ Tests(1)
v ﬁmeh) Id: |nva| com.vmware.unixdef1

oval:comymware.unixtst1 Title:
v ﬁ Objects(1) Ensure that ietc/passwd file has correct aliributes

v (&3 file(1)
oval.com vmware unixobj:1
¥ (& States(1)
¥ (5 file(1)
D oval:comvmware. unixste:1
» (& variables(0)

- vy T

[ Expand All ] [ Collapse All ]

You may then add, edit or remove any OVAL elements to this file as desired. Do not
forget to Save the file each time you have made changes to it that should be persisted.

vmware



Creating XCCDF file from an existing OVAL file

Using the tool, you can directly create a minimal XCCDF 1.2 file from an existing OVAL
file. To do this, just launch the tool and click on File > XCCDF from OVAL.

New OVAL
Open OVAL
KO

Browse the file, select it and click Open.

LookIn: [ﬁ' Desktop

test-oval.xml

File Mame: |test—wal.xm|

Files of Type: | OVAL files

vmware



Provide the desired reverse DNS string and click OK.

reverse_DMNS:
com.wnware.uni}d

Lok J | cancel |

Provide desired XCCDF file name and click Save.

LookIn: | (& Desktop

test-oval.xml

File Mame: | testxcod]

Files of Type: | All Files
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This would create a XCCDF 1.2 file from chosen OVAL file.
XCCDF Created

KCCDF File Created: C\lsers\kayush\Desktopitest-wocdf

OK

Click OK.

The generated XCCDF XML file looks like below:

k? version="1.0" encoding="UTF-8"2>
< xmlns="http://checklists.nist.gov/xccdf/1.2"
id="xccdf_com.vmware.unix_benchmark_generated-xccdf"
resolved="1">
>incomplete</ >
>Automatically generated XCCDF from OVAL file: test-oval.xml</ >
>This file has been generated automatically from oval definitions file.</
time="2016-06-05T04:12:31">None, generated from OVAL file.</ >

selected="true" id="xccdf_com.vmware.unix_rule_oval-com.vmware.unix-def-1">
< >Ensure that /etc/passwd file has correct attributes</ >
< system="http://oval.mitre.org/XMLSchema/oval-definitions-5">
href="test-oval.xml" name="oval:com.vmware.unix:def:1"/>

>

Modify the XML tags such as status, title, description and version and then your XCCDF
file is good to go. Optionally, you can manually create XCCDF profiles and groups, if
required.

You can then do XCCDF assessments or use the XCCDF to create SCAP source data
stream, if required.
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References

Below are some useful references.

OVAL core definition schema —
https://oval.mitre.org/lanquage/version5.11/ovaldefinition/documentation/oval-
definitions-schema.html

OVAL independent definition schema —
http://oval.mitre.org/language/version5.11/ovaldefinition/documentation/independent-
definitions-schema.html

OVAL Linux definition schema —
http://oval.mitre.org/lanquage/version5.11/ovaldefinition/documentation/linux-definitions-
schema.html

OVAL Unix definition schema —
http://oval.mitre.org/language/version5.11/ovaldefinition/documentation/unix-definitions-
schema.html

OVAL Windows definition schema —
http://oval.mitre.org/language/version5.11/ovaldefinition/documentation/windows-
definitions-schema.html

VMware STIG compliance tool —

https://blogs.vmware.com/security/2016/05/vmware-releases-stig-compliance-app-for-
free.html
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